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Copyright Notices
© 2010, Wyse Technology Inc. All rights reserved.

This manual and the software and firmware described in it are copyrighted. You may not reproduce, transmit, 
transcribe, store in a retrieval system, or translate into any language or computer language, in any form or by any 
means, electronic, mechanical, magnetic, optical, chemical, manual or otherwise, any part of this publication 
without express written permission.

End User License Agreement (“License”)
A copy of the Wyse Technology End User License Agreement is included in the software and provided for your 
reference only. The License at http://www.wyse.com/license as of the purchase date is the controlling licensing 
agreement. By copying, using, or installing the software or the product, you agree to be bound by those terms.

Trademarks
The Wyse logo and Wyse are trademarks of Wyse Technology Inc. Other product names mentioned herein are for 
identification purposes only and may be trademarks and/or registered trademarks of their respective companies. 
Specifications subject to change without notice.

Patents
This product and/or associated software are protected by copyright, international treaties, and various patents, 
including the following U.S. patents: 6,836,885 and 5,918,039.

Restricted Rights Legend
You acknowledge that the Software is of U.S. origin. You agree to comply with all applicable international and 
national laws that apply to the Software, including the U.S. Export Administration Regulations, as well as end-user, 
end-use and country destination restrictions issued by U.S. and other governments. For additional information on 
exporting the Software, see http://www.microsoft.com/exporting.

Ordering Information
For availability, pricing, and ordering information in the United States and Canada, call 1-800-GET-WYSE 
(1-800-438-9973) or visit us at http://www.wyse.com. In all other countries, contact your sales representative.

FCC Statement
This equipment has been tested and found to comply with the limits for either Class A or Class B digital devices, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and the receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Shielded interconnect cables and shielded AC power cable must be employed with this equipment to insure 
compliance with the pertinent RF emission limits governing this device. Changes or modifications not expressly 
approved by the system’s manufacturer could void the user’s authority to operate the equipment.

Caution
Modifications made to the product, unless expressly approved by Wyse Technology, could void 
the user’s authority to operate the equipment.

http://www.wyse.com/license
http://www.microsoft.com/exporting
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Regulatory Compliance for Thin Clients

Basic EMC and Safety Requirements
Wyse appliances are compliant with the regulatory requirements in the regions listed below.

U.S.A.—FCC Part 15 (class B), cUL 60950

Canada—IC ICES-003, CAN/CSA-C22 No. 60950

Europe—EN 55022 (class B); EN 55024

Canadian DOC Notices
Class A - This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus 
set out in the Radio Interference Regulations of the Canadian Department of Communications. 
Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux 
appareils numériques de la classe A prescrites dans le Réglement sur le brouillage radioélectrique édicté par le 
Ministère des Communications du Canada.

Class B - This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus 
set out in the Radio Interference Regulations of the Canadian Department of Communications. 
Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux 
appareils numériques de la classe B prescrites dans le Réglement sur le brouillage radioélectrique édicté par le 
Ministère des Communications du Canada.

Wireless Usage and Requirements
Radio transmitting type devices (RF module) are present in models with the wireless option. These devices 
operate in the 2.4 GHz band (i.e. 802.11B/G LAN & Bluetooth). 

As a general guideline, a separation of 20 cm (8 inches) between the wireless device and the body, for use of a 
wireless device near the body (this does not include extremities) is typical. This device should be used more than 
20 cm (8 inches) from the body when wireless devices are on and transmitting.

Some circumstances require restrictions on wireless devices. Examples of common restrictions include:
• When in environments where you are uncertain of the sanction to use wireless devices, ask the applicable 

authority for authorization prior to use or turning on the wireless device.
• Every country has different restrictions on the use of wireless devices. Since your system is equipped with a 

wireless device, when traveling between countries with your system, check with the local Radio Approval 
authorities prior to any move or trip for any restrictions on the use of a wireless device in the destination 
country.

• Wireless devices are not user-serviceable. Do not modify them in any way. Modification to a wireless device 
will void the authorization to use it. Please contact the manufacturer for service.

Device Power Supply
Use only the external power supply that comes with your thin client. For power and voltage ratings, see the serial 
number label or regulatory label on your device. For power adapter replacement, contact your Wyse Service 
Representative. For proper replacement compare the labels on both mobile thin client and power adapter to 
ensure that their voltages match. 

Warning
Use of any other power adapter may damage your mobile thin client or the power adapter. The 
damage caused by an improper power adapter is not covered by warranty.

Battery Information
Models Cx0, Rx0L, Rx0LE, Xx0C, and Xx0L contain an internal button cell battery replaceable by Wyse or one of 
our Authorized Service Centers. For service, visit http://www.wyse.com/serviceandsupport/service/service.asp.

Warning
There is a risk of explosion if the battery is replaced by an incorrect type. Always dispose of used 
batteries according to the instructions accompanying the battery. 
 
Perchlorate Materials - Special Handling May Be Required under California Code of Regulations, 
title 22. (Only required within the U.S.A.)

http://www.wyse.com/serviceandsupport/service/service.asp


Models Xn0L and Xx0C mobile thin clients contain a user-replaceable battery pack. The battery is designed to 
work with your Wyse mobile thin client. Do not use a battery from other mobile thin clients or laptop computers with 
your mobile thin client. Replace the battery only with a compatible battery purchased from Wyse's spare parts 
provider or one of our authorized service centers. For spare parts visit 
http://www.wyse.com/serviceandsupport/service/spares.asp.

Warning
There is a risk of explosion if the battery pack is replaced by an incorrect type. For Model Xn0L, 
always dispose of used batteries according to the instructions accompanying the battery. For 
Model Xx0C, always dispose of used batteries according to local ordinance and/or regulation.

Caution
Misuse of the battery pack may increase the risk of fire of chemical burn. Do not puncture, 
incinerate, disassemble, or expose the battery to temperatures above 65°C (149°F). Keep the 
battery away from children. Handle damaged or leaking batteries with extreme care. Damaged 
batteries may leak and cause personal injury or equipment damage.

http://www.wyse.com/serviceandsupport/service/spares.asp
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1 Introduction

Wyse® Enhanced SUSE Linux Enterprise (SLE) combines the security, flexibility, and 
market-leading usability of SUSE Linux Enterprise from Novell® with Wyse’s thin 
computing optimizations in management and user experience. It is ideal for organizations 
that want to run server-based, Web-based, or local applications (including legacy 
applications) without the deployment and security concerns of a non-standard Linux 
distribution.

Wyse Enhanced SLE comes pre-installed with the software needed for most thin 
computing deployments, including an ICA client, RDP client, Firefox Web browser, and the 
PowerTerm® Terminal Emulation client. You can extend this base functionality through 
easy-to-install add-ons qualified and available through Wyse (such as ThinPrint support) 
or other packages that have been qualified for Novell SUSE Linux Enterprise Thin Client. 
As with all Wyse platforms, Wyse Enhanced SLE has built in support for Wyse Device 
Manager (WDM) software, Wyse® TCX Suite™, and Wyse® Virtual Desktop Accelerator.

About this Guide
This guide is intended for administrators of Wyse thin clients running Wyse Enhanced 
SUSE Linux Enterprise (SLE). It provides information and detailed system configurations 
to help you design and manage a Wyse Enhanced SLE environment. 

Finding the Information You Need in this Guide
You can use either the Search window or Find toolbar to locate a word, series of words, or 
partial word in an active PDF document. For detailed information on using these features, 
refer to the Help in your PDF reader.

Wyse Technical Support
To access Wyse technical resources, visit http://www.wyse.com/support. If you still have 
questions, you can submit your questions using the Wyse Self-Service Center (on the 
Wyse.com home page, go to Support > Knowledge Base > Home tab) or call Customer 
Support at 1-800-800-WYSE (toll free in U.S. and Canada). Hours of operation are from 
6:00 A.M. to 5:00 P.M. Pacific Time, Monday through Friday.

To access international support, visit http://www.wyse.com/global.

Related Documentation and Services
Fact Sheets containing the features of hardware products are available on the Wyse Web 
site. Go to http://www.wyse.com/products/hardware, click the link for your hardware 
product, and then click the link for the Fact Sheet. 

http://www.wyse.com/support
http://www.wyse.com/products/hardware
https://support.wyse.com/OA_HTML/ibuhpage.jsp
http://www.wyse.com/global
http://www.wyse.com/products
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Reference Guide: Wyse ® Enhanced SUSE Linux Enterprise INI Files is intended for 
administrators of Wyse thin clients running Wyse Enhanced SUSE Linux Enterprise (SLE). 
It provides the detailed information you need to help you understand and use the Wyse 
Enhanced SLE INI files. It contains information on the different Wyse Enhanced SLE INI 
files you can use and the rules for constructing the files. It also provides the parameter 
details you need (with working examples) to get the most out of your Wyse Enhanced SLE 
INI files. In addition, this guide also includes an appendix that contains all of the supported 
connect options you can use for supported connections. It is available at: http://
www.wyse.com/manuals.

Wyse Thin Computing Software is available on the Wyse Web site at: 
http://www.wyse.com/products/software.

Wyse Online Community
Wyse maintains an online community where users of our products can seek and exchange 
information on user forums. Visit the Wyse Online Community forums at: 
http://community.wyse.com/forum. 

http://www.wyse.com/manuals
http://www.wyse.com/manuals
http://www.wyse.com/products/software/
http://community.wyse.com/forum


2 Getting Started

This chapter provides information to help you quickly get started using your thin client. It 
describes basic thin client functions and provides instructions on setting up the thin client 
for you and your users.

It includes:
• "Product Registration"
• "Logging In"
• "Using Your Desktop"
• "Using the Computer Menu"
• "Setting Up Thin Clients and Connections"
• "Connecting to Network and Session Services"
• "Connecting to a Printer"
• "Connecting to an External Monitor"
• "Shutting Down, Restarting, and Suspending"
• "Restoring Default Settings"
• "Enhancing Your Experience with Wyse Software"

Product Registration
After product purchase, you will receive an e-mail from Wyse containing instructions on 
registering your product.

Logging In
After your thin client starts, you can log in to your desktop using the default user name 
admin, and the default password admin. It is highly recommended that you change the 
default password by using the Change Password icon in the Control Center (see 
"Changing Passwords").
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Using Your Desktop 
The desktop provides various applications and tools for use.

Use the following guidelines:
• Computer button - Allows you to open and use the Computer menu (see "Using the 

Computer Menu").
• Power icon - Move the pointer over this icon to see a pop-up message that shows you 

whether your mobile thin client is running on AC power or battery power. The message 
also shows you (by percentage) your battery charge.

• Network Manager icon - Allows you to manage your network connections (see 
"Connecting to Network and Session Services").

• System Information icon - Allows you to open and use the System Information dialog 
box. Use this dialog box to view system information about the thin client (see "Viewing 
System Information").

• Display Settings icon - Allows you to set the monitor display settings (see 
"Configuring Display Settings").

• Volume icon - Allows you to control the audio volume (see "Configuring Volume 
Control Settings").

• Calendar - Lists the day of the week, date, and time. You can click the calendar to 
open a calendar window and reset the date. 
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Desktop Keyboard Shortcuts
Depending on the type of application window you are using (full screen, standard, or 
seamless), you can use shortcut keys (see Table 1) to manage windows.

Tip
The shortcut keys Alt+DownArrow (allows you to switch windows using a 
dialog box) and Alt+Ctrl+DownArrow (minimizes or maximizes all windows) 
are useful for navigating multiple remote sessions without having to log out.

Table 1 Window-related Shortcut Keys 

Window Action Press

Maximize window Alt+F10

Minimize window Alt+F9

Restore maximized window to 
previous size

Alt+F5

Move focus to next window Alt+Esc

Move focus to previous window Alt+Shift+Esc

Switch windows using a dialog box. Alt+DownArrow

Switch panel focus Alt+Ctrl+Shift+DownArrow

Show the window menu Alt+Space (you can also right-click the window 
title bar or border, or click the window icon)

Minimize/maximize all windows Alt+Ctrl+DownArrow

Move window with arrow keys Alt+F7 and press an arrow key

Resize window Alt+F8 and press an arrow key

Show desktop panel Alt+F1

Close the window Alt+F4
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Using the Computer Menu
Click the Computer button on the left side of the desktop panel to open the Computer 
menu. This menu provides quick access to frequently used programs and common 
system areas.

Tip
You can right-click an icon in the Control Center to add the application to your 
Favorite Applications area.

Use the following guidelines:
• Connection Manager - Opens the Connection Manager. Use the Connection 

Manager to view, use, and locally configure connections on the thin client as described 
in "Using and Configuring Connections with the Connection Manager."

• Firefox - Opens the Firefox Web Browser.
• More Applications - Opens the Application Browser. Use the Application Browser to 

use and manage applications on the thin client. For more information, see "Accessing 
Applications with the Application Browser."

• Control Center - Opens the Control Center. Use the Control Center to configure the 
hardware, look and feel, and system settings of your thin client as described in "Setting 
Up the Thin Client Using the Control Center."

• Lock Screen - Locks your desktop screen (desktop displays blank after you click the 
icon). To restore your screen, move the mouse, enter your credentials, and then click 
Unlock.

• Logout - Opens the Log Out dialog box (click Log Out to end your session but 
continue to run the thin client).

• Shutdown - Opens the Shutdown dialog box (where you can shut down your thin 
client, restart your thin client, or put your thin client in Standby mode - see "Shutting 
Down, Restarting, and Suspending").

Setting Up Thin Clients and Connections
While Wyse Enhanced SLE INI Files can be used to set up the thin clients in your 
environment and configure the connections available to users (as described in 
"Automating Thin Client Configurations and Updates" and Reference Guide: Wyse ® 

Enhanced SUSE Linux Enterprise INI Files), you can use the:
• Control Center to locally set up your thin client hardware, look and feel, and system 

settings (as described in "Setting Up the Thin Client Using the Control Center").
• Connection Manager to locally configure connections for use (as described in "Using 

and Configuring Connections with the Connection Manager").
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Connecting to Network and Session Services
The Network Manager icon, located on the right side of the desktop panel, displays 
information about your network connection. Move the pointer over the Network Manager 
icon to view a pop-up message displaying the name of the network to which your thin 
client is connected. If a red X appears on this icon, your thin client is not connected to the 
network. Connect your thin client to the wired network by attaching the network cable to 
your thin client (the Connection Established message appears).

For wireless connections (802.11b/g/n Wireless LAN), you can hover over the Wireless 
Network Connection icon in the taskbar to see if a wireless network connection is 
available, and then double-click the Wireless Network Connection icon to open and use 
the Wireless Networks menu.

Tip
For information on importing certificates that your network may require, refer 
to "Importing Certificates."

Connecting to a Printer
To connect a parallel printer to your thin client through a USB port, you will need a 
USB-to-printer adapter cable (not included). Before use, you may need to install the driver 
for the printer by following the printer driver installation instructions. For information on 
connecting to printers, refer to "Setting Up and Managing Printers."

Connecting to an External Monitor
Thin clients have a VGA (analog) monitor port (supported mobile thin clients also have a 
DVI port) for connecting your thin client to an external monitor. For information on 
connecting to external monitors, refer to "Configuring Display Settings."

Shutting Down, Restarting, and Suspending
After using your thin client, you can click Computer > Shutdown to open and use the 
Shutdown dialog box to:
• Shutdown - Shuts down and turns off your thin client.
• Restart - Shuts down and restarts your thin client.
• Suspend - Places the thin client in Standby mode to preserve power. To exit Standby 

mode, click the mouse.

Tip
If the ReadyMode feature has been enabled and the thin client is shut down, 
the session ends, the power button LED is put in a state of OFF, and the thin 
client is placed in Standby mode to preserve power. Upon pressing the power 
button, the thin client exits Standby mode, and immediately prompts the user 
with the login dialog box. For more information on ReadyMode, see the 
Advanced tab in "Configuring Device Settings."
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Restoring Default Settings
Depending on the default settings you want to restore on the thin client, you can use either 
the BIOS (to restore default values for all the items in the BIOS setup utility), G key reset 
(to restore default users settings), or the Thin Client Settings dialog box (to restore all 
factory default settings).

Accessing Thin Client BIOS Settings
After starting your thin client you will see a Wyse logo for a short period of time. During this 
period you can press and hold the F2 key (Models Xn0L and Xx0C) or the Delete key 
(Models Cx0, Rx0L, and Rx0LE) to enter the BIOS to make your modifications (enter 
Fireport as the password). For example, you can use the F9 key to Setup Defaults (load 
optimal default values for all the items in the BIOS setup utility).

Restoring Default User Settings 
You can restore default user settings (user customizations are deleted, however, add-on 
applications that you installed are retained, and applications that you removed are not 
restored) by using the:
• Restore factory defaults when upgrading check box in the Thin Client Settings 

dialog box when updating firmware (see "Configuring INI and Upgrade Settings").
• Reset to Factory Defaults command button in the Advanced tab of the Device 

Settings dialog box (see "Configuring Device Settings").
• G-key Reset feature (a PS/2 keyboard is required). To use this type of restoration, 

when you see the splash screen during system boot (the screen reads, “SUSE Linux 
Enterprise Desktop” and displays a progress bar), hold down the G key to restore the 
default user settings.

Restoring All Original Factory Default Settings When Updating Firmware
Use the Thin Client Settings dialog box to restore all factory default settings when 
updating firmware. 

1. Click the Computer button on the desktop panel and select Control Center to open 
the Control Center.

2. Click INI and Upgrade Settings to open the INI and Upgrade Network Settings 
dialog box. 

3. If necessary, clear the Get INI and upgrade server details via DHCP check box.

4. Click Image upgrade settings to open the Thin Client Settings dialog box.

5. Select the Restore factory defaults when upgrading check box.

6. Select the Force base system update check box.

7. Click OK.
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Enhancing Your Experience with Wyse Software
Wyse provides several software products that are specifically designed to enhance your 
thin client experience. Wyse Thin Computing Software is available on the Wyse Web site 
at: http://www.wyse.com/products/software.

Wyse Device Manager (WDM)
Wyse Device ManagerTM (WDM) servers provide network management services to the 
thin client (complete user-desktop control—with features such as remote shadow, reboot, 
shutdown, boot, rename, automatic device check-in support, Wake-On-LAN, change 
device properties, and so on). With WDM you can manage all of your network devices 
from one simple-to-use console.

Wyse TCX Suite
Wyse® TCX Software™ provides an enrichment layer above ICA and RDP connections 
that enable flash acceleration, multiple monitor awareness, rich multimedia playback, high 
quality bidirectional audio capabilities, and seamless USB device access for Wyse thin 
clients. Each software component in the suite delivers a specific enhancement designed 
to work seamlessly within a variety of prevalent backend infrastructure solutions such as 
Microsoft® Terminal Services, Citrix® XenApp, Citrix® XenDesktop, and VMware® View or 
Virtual Desktop Infrastructure.

Wyse TCX Suite includes:
• Wyse® TCX Flash Acceleration™
• Wyse® TCX Multi-display™ 
• Wyse® TCX Multimedia™
• Wyse® TCX Rich Sound™ 
• Wyse® TCX USB Virtualizer™ 

Wyse USB Firmware Tool 
The Wyse® USB Firmware ToolTM provides a simple USB imaging solution to help IT and 
Customer Service staff quickly and easily image supported devices.

Using the tool’s flexible windows utility, users can easily: 
• Configure a USB key to copy/pull firmware from a source device (to later push to other 

target devices)
• Configure a USB key to update/push firmware (that you include on the USB key) to 

target devices (to update firmware)
• Create replicate/duplicate USB keys (containing the original contents) for simultaneous 

usage on target devices (by users in several locations at the same time)

Wyse Virtual Desktop Accelerator
Wyse® Virtual Desktop Accelerator (VDA) is a software product that, when used with 
Wyse thin clients and supported PCs, provides an “accelerated” user experience on 
remote desktop sessions with high round-trip delay between the server and client. By 
accelerating the remote desktop protocols by a factor of up to 3 times on certain networks, 
a Wyse VDA session with a server located thousands of miles from your client “feels” 
similar to a non-accelerated session with a server located just a few hundred miles from 
your client.

http://www.wyse.com/products/software
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Built for use on high-bandwidth high-latency networks that are prone to packet loss 
situations, primary use cases for Wyse VDA include:
• Datacenter Consolidation
• Desktop Cloud Computing
• Remote Off-Shore Desktop Computing



3 Automating Thin Client 
Configurations and Updates
This chapter contains information on how to configure the network environment so that 
your thin clients can configure and update themselves automatically (highly 
recommended). 

It includes:
• "Understanding Automatic Configurations and Updates"
• "How INI files Are Employed"
• "How to Set Up Automatic Configurations and Updates"

For detailed information on constructing and using Wyse Enhanced SLE INI files, refer to 
Reference Guide: Wyse ® Enhanced SUSE Linux Enterprise INI Files.

Tip
Wyse® Enhanced SUSE Linux Enterprise (SLE) does not require device 
management software. Your thin client is configured to obtain its IP address, 
as well as the location of firmware and configuration instructions, from a 
DHCP server. You can use "Wyse Device Manager (WDM)" or the "Wyse 
USB Firmware Tool" for a more hands-on management of client 
configurations and updates. For information about configuring thin clients to 
communicate with a WDM server, see "Configuring the WDM Agent" and 
related INI parameters in Reference Guide: Wyse ® Enhanced SUSE Linux 
Enterprise INI Files. 

Understanding Automatic Configurations and Updates
At each boot up, Wyse Enhanced SLE checks to see whether any updates are available 
on a predefined file server, and if updates are available, the updates are installed 
automatically. Firmware and any additional software (add-ons) that are on the thin client 
are replaced by their up-to-date versions on the server.

Tip
Only pre-existing add-ons are pulled from the server. If you want to place 
new add-ons on the thin client, use the Novell Add-on Manager available in 
the Control Center (see "Using Novell Add-on Manager").
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How INI files Are Employed
INI files determine how the thin client is configured and updated. The thin client accesses 
INI files from the server during the initialization process. The network administrator 
creates and maintains these INI files. Typically, INI files are accessed through FTP, HTTP, 
and HTTPS; if no protocol is specified, the default is anonymous FTP.

INI files are employed as follows: 
• wlx.ini - This is the global INI file. One wlx.ini file is available to all users. It 

contains global parameters for all thin clients accessing the server. If the operating 
system cannot find wlx.ini, it defaults to wnos.ini.

• {username}.ini - This file is unique to each user. The {username}.ini file 
contains the connection profile for each user. Parameters in the user profile generally 
supersede the identically named global parameters.

• $MAC.ini - This file can be used for device-specific configuration. If the thin client 
locates this INI file (it is stored in the same directory as wlx.ini), wlx.ini is not 
accessed, unless you use the include=wlx.ini parameter.

When a thin client is initialized, it accesses the global wlx.ini file. When a user logs in, 
the thin client accesses the user’s unique {username}.ini file.

Descriptions of INI file commands and parameters can be found in Reference Guide: 
Wyse ® Enhanced SUSE Linux Enterprise INI Files.

Tip
If both PNLite and a user profile are being used, the username must be 
defined in the Windows domain to be used, and the password must be the 
same for the domain and the profile.
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How to Set Up Automatic Configurations and Updates
For the thin client to successfully access INI files and update itself from the server, you 
must set up the file server with the correct folder structure and “point” the thin client to the 
file server where the INI files and other update files are located. Finally, you must reboot. 
These tasks are described in the following steps.

Step 1: Preparing the Root Directory and Folder Structure on the File Server
The following list describes the folder structure, starting with the root directory.
/wyse/ The root directory. It stores the wlx directory and the addons 

directory. 
It also stores these files, which are used for imaging and updating 
devices: Latest-image.raw and 
Latest-image.raw.info.

/wyse/wlx The main INI configuration folder. It stores the bitmap, certs, 
and ini directory.
It also stores these files: wlx.ini or $MAC.ini.

/wyse/wlx/bitmap Stores custom icons and other images.

/wyse/wlx/certs Stores certificates to import to the thin client using the INI 
commands Certs and ImportCerts. 

/wyse/wlx/ini Stores the {username}.ini file.

/wyse/addons Stores add-ons. 
It also stores the directory file and the *.rpm packages 
available to be installed on the thin client. The directory file 
should list all available add-ons. The directory file is required 
in the addons folder to guarantee that add-ons are properly 
located.

NOTE: If you want to do an update with the Preserve changes 
option enabled, make sure that your addons directory includes a 
copy of your current add-ons. The system may require two 
reboots to fully update the firmware and add-ons while preserving 
local changes.
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The following figure shows how to set up the folder structure on your file server and where 
to place INI files and other necessary files inside the structure.

Caution
The location of the addons folder is part of the root path directory (Wyse). 
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Step 2: “Pointing” the Thin Client to the File Server
After you set up the folder structure and populate it with the correct files, the next step is to 
point the thin client to the server location. The thin client can obtain the location of the 
server in two different ways, using DHCP or manually configuring the file server location. 
Using DHCP is strongly recommended.

Using DHCP
With the DHCP method of configuring the file server location (recommended), information 
about the server and root directory is obtained from DHCP option tags 161, 162, 184, and 
185 (refer to Table 2 for complete descriptions of these option tags): 
• 161 - The server URL (full URL including the root path).
• 162 - Root path to the file server (ftp/http/https) (for backward compatibility).

· If no root path is defined, /wyse is assumed.
· If a root path is defined, the additional path will be appended to the URL supplied by 

tag 161.
• 184 - Wyse file server user name.
• 185 - Wyse file server password.

Tip
Check-in for firmware updates is done early in the boot process. For that 
reason, changes in DHCP information may not be propagated to a unit until a 
full boot is completed. However, you can avoid this by forcing a renewing of 
the DHCP lease, which makes sure that the unit has the latest file-server 
location before the next firmware check. Open the System Information 
dialog box (click the System Information icon on the desktop panel), click 
the Network tab, click the Release button, and then click the Renew button.

Table 2 describes all DHCP option tags.

Table 2 DHCP Option Tags 

Option Description Notes

1 Client identifier Always sent

2 Time Offset Optional.

3 Router Optional but recommended. It is not required 
unless the appliance must interact with servers 
on a different subnet.

6 Domain Name Server
(DNS)

Optional but recommended. 

12 Host Name/Terminal 
Name

Optional string. The host name or terminal name 
to be set.

15 Domain Name Optional but recommended. See Option 6.

28 Broadcast Address Optional. 

44 WINS servers IP 
Address 

Optional. 

51 Lease Time Optional but recommended. 

52 Option Overload Optional. 
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53 DHCP Message Type Recommended. 

54 DHCP Server IP 
Address

Recommended. 

55 Parameter Request 
List

Sent by appliance.

57 Maximum DHCP 
Message Size

Optional (always sent by appliance).

58 T1 (renew) Time Optional but recommended.

59 T2 (rebind) Time Optional but recommended.

61 Client identifier Always sent.

161 Server address or 
URL

Optional string. If this is an IP address or 
resolvable hostname, the protocol is assumed to 
be FTP; however, it may be the leading portion of 
a URL that specifies another protocol. If using the 
URL form, it should not include a trailing slash 
(for example, http://server.example.com or ftp://
192.168.0.1).

162 Root path to the file 
server (ftp/http/https)

Optional string. The relative directory starting 
from the root directory must be given. For 
example, on a Windows FTP server, the full 
directory may be C:\Inetpub\ftproot\wyse, 
where wyse is the directory that contains the 
firmware. In this example, the correct string value 
for this DHCP option is /wyse. 
On a Linux server, an FTP user-based directory 
might be /home/test/wyse. In this example, if 
the FTP user is test, then the FTP root path is  
/wyse and not the full path (/home/test/wyse).
This value should use URL path notation (start 
with a forward slash, /, and use a forward slash 
as folder separators).

181 Wyse PN Server Optional string. IP address or FQDN of the 
PNLite server.

182 Wyse Admin List Optional string. DHCP equivalent of the 
DomainList ini file parameter.

184 Wyse File Server 
Username 

Optional string. Username to use when 
authenticating to the server specified in Option 
161.

185 Wyse File Server 
Password 

Optional string. Password to use when 
authenticating to the server specified in Option 
161.

186 Wyse Rapport Servers Optional binary IP addresses. IP address or 
FQDN of the WDM server. Does not require 
option 187 to be specified.

Table 2 DHCP Option Tags, Continued

Option Description Notes
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Manually Configuring the File Server Location
To manually configure the file server location (not recommended), open the INI and 
Upgrade Settings dialog box, and enter the address in the INI Server URL text box. For 
more information, see "Configuring INI and Upgrade Settings." 

Tip
You can click Image Upgrade Settings to configure the INI and upgrade 
network settings as described in "Configuring the Image Upgrade Options."

Step 3: Rebooting
After you reboot, the thin client will look in the defined root path for the latest available 
image and update if necessary. Additionally, it will check the directory file in the addons 
folder to see if any updates for installed add-ons are defined. Add-ons that exist in the 
addons folder but are not listed in the directory file, will be ignored during update check-in.
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4 Setting Up the Thin Client Using the 
Control Center
This chapter contains information to help you set up your thin client hardware, look and 
feel, and system settings using the Control Center.

Tip
Configurations made in the Control Center only apply to the thin client you 
are using. If you want to configure more than one thin client at a time or 
configure thin clients remotely, Wyse recommends configuring thin client 
settings using INI files as described in "Automating Thin Client 
Configurations and Updates." 

Caution
Some thin client information, applications, and system configurations are 
saved and remain persistent after reboot for high-privilege users only. 

Clicking Control Center in the Computer menu (see "Using the Computer Menu") or in 
the Connection Manager (see "Using and Configuring Connections with the Connection 
Manager") opens the Control Center. You can use the Control Center to set up your thin 
client settings and preferences.

Tip
You can right-click an icon in the Control Center to add the application to your 
Favorite Applications area (shown in the Computer menu) or to your Startup 
Programs.
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This chapter includes information on:
• "Configuring Display Settings"
• "Configuring Keyboard Preferences"
• "Configuring Mouse Preferences"
• "Setting Up and Managing Printers"
• "Customizing the Look of the Desktop"
• "Setting the Language"
• "Selecting Audio Devices"
• "Changing Passwords"
• "Configuring VDA" 
• "Configuring Desktop Appliance Mode"
• "Configuring Device Settings"
• "Configuring ICA Global Settings"
• "Importing Certificates"
• "Configuring INI and Upgrade Settings"
• "Configuring Network Connections"
• "Using Novell Add-on Manager"
• "Power Management"
• "Setting Screensaver Preferences"
• "Viewing System Information"
• "Using TCX USB Virtualizer"
• "Managing Thin Client Users"
• "Setting VNC Server Preferences for Shadowing"
• "Configuring the WDM Agent"
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Configuring Display Settings
Clicking the Display icon in the Control Center opens the Display Preferences dialog 
box. Use this dialog box to set the monitor display settings (Primary Display Output, 
Resolution, Refresh Rate, and Rotation). For most monitors, resolution is obtained 
automatically from the monitor. Note that screen rotation is not currently supported.

Configuring Keyboard Preferences
Clicking the Keyboard icon in the Control Center opens the Keyboard Preferences 
dialog box. Use this dialog box to select general (repeat key and cursor blinking), layout 
(keyboard models and layout options), accessibility (sticky key, slow key, bounce, key 
audio feedback), mouse keys (keypad control of pointer), and typing break (reminder) 
preferences.
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Configuring Mouse Preferences
Clicking the Mouse icon in the Control Center opens the Mouse Preferences dialog box. 
Use this dialog box to select general (mouse orientation, locate pointer, pointer speed, 
drag-and-drop, double-click time out) and accessibility (simulated secondary click and 
Dwell click) preferences.

Setting Up and Managing Printers
Clicking the Printing icon in the Control Center opens the Printer Configuration dialog 
box. Use this dialog box to:
• View the list of currently configured printers.
• Add and configure a network or local printer (click the New icon to open and use the 

New Printer wizard).
• Select the default printer (select a printer in the list and click Printer > Set as Default). 

Note that administrators can specify system-wide and personal default printers.
• Change printer settings (right-click a printer in the list, select Properties, and then click 

Settings).
• Change printer policies (right-click a printer in the list, select Properties, and then click 

Policies).
• Change user access to the printer (right-click a printer in the list, select Properties, 

and then click Access Control).
• Change printer job options (right-click a printer in the list, select Properties, and then 

click Job Options).
• Delete a printer (right-click a printer in the list, select Delete, and click OK).
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Installing a Network Printer
1. Click the New icon in the Printer Configuration dialog box to open the New Printer 

wizard.

2. Select the printer option you want from the Devices list and follow the New Printer 
wizard using the following guidelines:
• AppSocket/HP JetDirect - Use this option for a printer connected directly to the 

network instead of through a computer.
• Forward print job data like a pipe to another command - Use this option to 

“pipe” the output of the printing command into another command or to “redirect” the 
output to a file.

• Internet Printing Protocol (IPP) - Use this option for a printer attached to a 
different Linux system on the same network running CUPS or a printer configured 
on another operating system to use IPP (http printing).

• LPD/LPR Host or Printer - Use this option for a printer attached to a different UNIX 
system that can be accessed over a TCP/IP network (for example, a printer 
attached to another Linux system on your network) or a thin client used as an LPD 
(Line Printer Daemon) server for LPD printing requests from the network. You can 
enter the DNS or WINS name of the server for the network printer, or an IP address 
can also be entered. Note that if the printer is attached to another thin client on your 
network, the entry in the Host box is the name or address of that thin client.

• Windows Printer via SAMBA - Use this option for a printer attached to a different 
system that is sharing a printer over an SMB network (for example, a printer 
attached to a Microsoft Windows machine). 

• Other - Use this option for other device Uniform Resource Identifier (URI) needs.
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Installing a Local Printer
Connect the printer cable to your thin client and use the following guidelines:

1. Click the New icon in the Printer Configuration dialog box to open the New Printer 
wizard.

2. Be sure the USB printer you connected to your thin client is selected and click 
Forward.

Tip
You can use the Serial Port # 1 and Serial Port # 2 options as needed for 
your local serial port printers.

3. Select the option with which you want to obtain your printer driver and click Forward.
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4. Select the Model and Driver and click Forward.

5. Enter the Printer Name, Description, Location, and then click Apply. The printer is 
added to the Printer Configuration dialog box and is ready for use.

Customizing the Look of the Desktop
Clicking the Appearance icon in the Control Center opens the Appearance Preferences 
dialog box. Use this dialog box to set the desktop display settings (Theme, Background, 
Fonts, and Interface). It is recommended to use default settings for best performance.
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Setting the Language
Clicking the Language icon in the Control Center opens the Select a Language dialog 
box. Use this dialog box to select the language of the User Interface (UI) from the list of 
supported languages (select the language you want and click OK). Note that currently 
only English is supported.

Tip
Additional language packs can be downloaded as they become available 
from Wyse at: www.wyse.com/download.

Selecting Audio Devices
Clicking the Audio Devices icon in the Control Center opens the Audio Devices dialog 
box. Use this dialog box to view and change the automatically-detected audio device (for 
example, a connected audio headset/device will be automatically detected) you want to 
use for your audio output (select the device you want and click OK). 

Changing Passwords
Clicking the Change Password icon in the Control Center opens the Change Password 
dialog box. Use this dialog box to change the Admin password (for login) and root 
password. 

To change a password, select the check box you want (Change Password for ‘Admin’ or 
Change Password for ‘root’), enter a New Password for the option (and enter again in 
the Confirm Password box), and then click OK. 

Tip
Linux users who have a root password have high privileges. By default, the 
Allow ssh root login option is disabled for security purposes. You can enable 
ssh root login by selecting the Allow ssh root login check box.

http://www.wyse.com/serviceandsupport/support/downloads.asp
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Configuring VDA
Clicking the Configure VDA icon in the Control Center opens the Global VDA Config 
dialog box. Use this dialog box to enable or disable Wyse Virtual Desktop Accelerator (to 
accelerate protocols such as Microsoft RDP and Citrix ICA). 

Configuring Desktop Appliance Mode
Clicking the Desktop Appliance icon in the Control Center opens the Desktop 
Appliance Configuration dialog box. Use this dialog box to configure your thin client to 
easily access your XenDesktop. Once the thin client is in Desktop Appliance Mode, a user 
can login to a XenDesktop with an “Out-of-the-box HDX Plug-n-play” experience.

Use the following guidelines:

1. Select the Desktop Appliance Mode check box.

2. Enter the XenDesktop URL (this is the location of the XenDesktop server where you 
can log in and use your desktop). Note that Desktop Appliance Mode can also be 
enabled through the INI parameters EnableApplianceMode=Yes and Xendesktop 
URL=<URL> as described in "Automating Thin Client Configurations and Updates."

3. Click OK to open the confirmation message.

4. Click OK to reboot the thin client. 
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5. Upon system reboot the thin client will connect to your XenDesktop server and prompt 
you for your XenDesktop login credentials (enter your login credentials to access your 
desktop).

Tip
To exit Desktop Appliance Mode and allow normal log in after system start, 
administrators can use ALT+F4 to display the Desktop Appliance Admin 
Login dialog box, where you can enter your administrator login credentials 
and access the Control Center to use the Desktop Appliance icon and clear 
the Desktop Appliance Mode check box (be sure to click OK to reboot the 
thin client).

6. (Administrators Only) While in Desktop Appliance Mode, administrators can use 
ALT+F4 to display the Desktop Appliance Admin Login dialog box, where you can 
enter your administrator login credentials and access the Control Center for 
administrative setup.
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Configuring Device Settings
Clicking the Device Settings icon in the Control Center opens the Device Settings dialog 
box. Use this dialog box to set the parameters of your device. After configuring the 
settings you want, be sure to click OK.

Tip
The COM tab will not appear for mobile thin clients.

Terminal Name
Use the Terminal Name tab to obtain the device name:
• Contact DHCP server - Obtains the name from the DHCP server.
• DNS reverse lookup - Obtains the name from a DNS reverse lookup.
• Derive from MAC address - Generates the name from the device MAC address.
• Use the following name - Allows you to manually enter a name.

Hosts
Use the Hosts tab to add mappings of IP addresses to hostnames that are not available 
through DNS (the names of mapped addresses appear on the Hosts tab): 
• Adding an IP address - Click Add to open the /etc hosts entry dialog box, enter an 

IP Address, Hostname (and optionally, Aliases), and then click OK.
• Editing a Host - Select a host from the list, click Edit, and configure the host.
• Deleting a Host - Select a host from the list and click Delete.
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Ethernet 
Use the Ethernet tab to select the Ethernet speed.

COM 
Use the COM tab (not available for mobile thin clients) to select COM1 and COM2 Speed, 
Parity, Size, Flow control, and Stop bits (the size of the stop bit with respect to the size of 
all the other signaling bits in a character).

NTP 
Use the NTP tab to enter the IP Address or hostname of the Network Time Protocol (NTP) 
server (the current NTP server is shown) to synchronize the clock time and date of the thin 
client (you can use the Sync button to synchronize immediately).
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Advanced 
Use the Advanced tab to:
• Enable or disable ReadyMode - You can use ReadyMode for easy login after thin 

client shut down. If the ReadyMode feature has been enabled (select the ReadyMode 
check box) and the thin client is shut down, the session ends, the power button LED is 
put in a state of OFF, and the thin client is placed in Standby mode to preserve power. 
Upon pressing the power button, the thin client exits Standby mode, and immediately 
prompts the user with the login dialog box.

• Restore default user settings - When you use the Reset to Factory Defaults 
command button, user customizations are deleted. However, add-on applications that 
you installed are retained, and applications that you removed are not restored.



32 Chapter 4
Configuring ICA Global Settings
Clicking the ICA icon in the Control Center opens the ICA Global Settings dialog box. 
Use this dialog box to configure the common settings you want for all ICA connections. 
After configuring the settings you want, be sure to click OK.

Network
Use the Network tab to configure the servers and reconnection settings.

Use the following guidelines:
• PN Agent Server - Enter the PN Agent Server you want to use (this can be a list of 

servers with each server separated by a semi-colon).
• Metaframe Server - Enter the Metaframe Server you want to use (this can be a list of 

servers with each server separated by a semi-colon).
• Browsing Protocol - Select the browsing protocol to use from the list.
• PN Logon Domains - Enter the PN logon domains.
• Seamless - Select to display the connection in a seamless window.
• Application Reconnection - Select the Automatic reconnection at logon check box 

to enable reconnection, and then select the connect option you want. 
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Drive Mapping
Use the Drive Mapping tab to map drives on the server to devices on the thin client, and to 
view and manage (add, edit, and delete) the list of current drives (including drive 
information) mapped on the thin client.

Adding Drives
1. Click Add to open the ICA Drive Map dialog box.

2. Select a drive letter (A to Z) from the Drive Letter list.

3. To enable or disable reading and writing for the drive, select or clear the Enable Read 
and Enable Write check boxes.

4. Select a drive type (USB Floppy, USB CDROM, USB Disk or Memory Stick, or 
Local or Mounted Disk) from the Drive Type list.

5. (Optional) Enter the directory on the USB device to access in the Base Directory text 
box.

6. Click OK to add the drive to the list of available drives.

Editing and Deleting Drives
To edit or delete a drive, select a drive from the list of available drives and do one of the 
following:
• Edit - Click Edit and configure the drive as described in "Adding Drives."
• Delete - Click Delete to remove the drive.
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Hotkeys 
Use the Hotkeys tab to map hotkeys on the thin client, and to view and manage (add, edit, 
and delete) the list of current hotkeys mapped on the thin client. To set the hotkeys, select 
a Hotkey option using the Hotkey lists for each function you want.

COM Ports 
Use the COM Ports tab to map COM ports on the server to devices on the thin client, and 
to view and manage (add and delete) the list of current COM ports (including device 
information) mapped on the thin client.

Adding COM Ports
1. Click Add to open the Add COM Port Mapping dialog box.

2. Select a COM Port (1 to 4) from the COM Port list.

3. Select a device from the Device list.

4. Click OK to add the COM port and device to the list of available COM Ports.

Deleting COM Ports
To delete a COM Port, select a COM Port from the list of available COM Ports and click 
Delete.
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Display 
Use the Display tab to set the Scroll Adjustment (select an adjustment option) and 
PrintScreen (select or clear the check box) on the thin client.

Use the following guidelines:
• Scroll Adjustment - If you encounter over-scrolling when using certain published 

applications, increase the adjustment by 100 until the display improves (maximum 
scroll adjustment is 1000).

• PrintScreen - Select to use the Print Screen key to capture an image of the desktop to 
the Clipboard (used for ICA XCapture support). If the check box is selected, a 
message appears warning about the influence of this setting on other applications).

Firewall 
Use the Firewall tab to set the firewall configurations on the thin client:
• Automatically detect proxy - Detects proxy servers automatically.
• Use Alternate Address for Firewalls - Enables connections behind a firewall 
• Proxy Type - Select a Proxy Type from the list and if necessary (Secure (HTTPS) or 

SOCKS, enter the Proxy Address and Port).
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Trusted Server Configuration 
Use the Trusted Server Configuration tab to set and enforce the trusted server 
configurations. To enforce a trusted server configuration, select the Enabled option, select 
the Enforce trusted server configuration dialog box, enter the Address of the trusted 
server, and then click OK (you can also use the Enabled or Disabled options to quickly 
enable or disable the enforcement configuration).
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Importing Certificates
Clicking the Import Certificates icon in the Control Center opens the Import Certificates 
dialog box. Use this dialog box to import and manage (add and delete) ICA Digital 
Certificates as described in "Adding Certificates from a Remote Server" and "Adding 
Certificates from a Local Device."

Adding Certificates from a Remote Server
Use the following guidelines (certificate files you add from a remote server must end with 
the extension .crt, and be DER-encoded or Base64-encoded):

1. In the Import Certificates dialog box, click Add to open the Add Certificate dialog 
box.

2. Select the Remote Server option, and then click Next to open the Certificate Import 
Server Settings dialog box.

3. Select the Remote Certificate Source server option that contains the certificate you 
want. If you select the Use the following Server option, enter the Import Server URL 
(supported protocols are ftp, http, and https) and the User name, and Password 
required for that server.

4. Select the certificate file from the Certificate file list (if the Import Server URL, User 
name, and Password are entered correctly, this list automatically displays the names of 
available certificates on the server).

5. After the configuring the Remote Certificate Source server option you selected, click 
Add.
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Adding Certificates from a Local Device
1. In the Import Certificates dialog box, click Add to open the Add Certificate dialog 

box.

2. Select the Local Server option, and then click Next to open the Open File dialog box.

3. Use the folders and command buttons to find and select the certificate you want to use.

Configuring INI and Upgrade Settings
Clicking the INI and Upgrade Settings icon in the Control Center opens the INI and 
Upgrade Network Settings dialog box. Use this dialog box to configure INI file 
downloads and image updates from the server. You can configure the downloads by using 
DHCP options or by manually entering the server address.

Caution
Wyse recommends obtaining INI files from DHCP options rather than from a 
static IP address. For information about how INI files and images are 
downloaded from the server, see "How to Set Up Automatic Configurations 
and Updates."

Tip
Wyse devices also support INI updates through Wyse Device Manager’s 
DDC (see "Wyse Device Manager (WDM)" and "Configuring the WDM 
Agent").
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Obtaining INI and Upgrade Server Details from DHCP
To obtain INI file downloads and image updates from the DHCP server, select either the 
Use INI files from server only or If available, use INI files from server only; otherwise 
use local INI files option, select the Get INI and Upgrade server details via DHCP 
check box, and then click OK.

Manually Configuring the INI Server URL
If you want your thin client to obtain INI file information from a static address rather than a 
DHCP server, use the following guidelines: 

1. Select either the Use INI files from server only or If available, use INI files from 
server only; otherwise use local INI files option.

2. Clear the GET INI and Upgrade server details via DHCP check box.

3. Manually enter a server address in the INI server URL text box.

4. If the server requires authentication, click the Server requires authentication check 
box, and then enter a username and password.

5. Click OK.

You can click Image Upgrade Settings to configure the INI and upgrade network settings 
as described in "Configuring the Image Upgrade Options." 

Configuring the Image Upgrade Options
Using the INI and Upgrade Network Settings dialog box, you can configure how the 
image on the thin client is updated if you manually configured the INI server URL as 
described in "Manually Configuring the INI Server URL." 

In the INI and Upgrade Network Settings dialog box, click the Image Upgrade Settings 
to open and use the Thin Client Settings dialog box. 

Use the following guidelines:
• Update Mode - select either:

· No Update - Image updates are disabled.
· Base System & Add-ons - The base image and add-ons are updated at each 

reboot.
· Base System Only - Only the base image is updated at each reboot.
· Add-ons Only - Only add-ons are updated at each reboot.

• Enter the Update Server URL. If the server from which the thin client updates requires 
authentication, select the Server required authentication check box and enter the 
Username and Password.
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• Restore factory defaults when updating - When selected, removes all local-machine 
customizations when software is updated from the file server. This setting is enabled 
by default and is recommended. However, if you want to keep locally defined 
connections or custom changes to installed applications, you can clear this check box.

Tip
In order to update with the Restore factory defaults when updating option 
disabled, you must have a properly set-up addons folder with a directory file 
that defines which software versions you want on the thin client. Moreover, it 
may take two full reboots to restore the latest software as well as your 
customizations.

• Force base system update - If you want to install the image and add-ons available on 
the file server regardless of whether or not they are the same as the currently installed 
image and add-ons on the thin client, select this check box.

Tip
The Restore factory defaults when updating option and the Force base 
system update option are useful when you want to fully restore the unit to 
factory defaults. These options remove any customizations and install only 
the base image supplied by Wyse.

• Click OK to return to the INI and Upgrade Network Settings dialog box.

Configuring Network Connections
Clicking the Network Connections icon in the Control Center opens the Network 
Connections dialog box. Use this dialog box to configure the settings you want for 
supported network connections. Use the Wired, Wireless, Mobile Broadband, VPN, and 
DSL tabs to view and manage (add, edit, and delete) the list of network connections 
configured on the thin client. By default, your thin client obtains information from the DHCP 
server about network connections (highly recommended), but you can manually enter 
connection information to connect to other networks (experienced users only). 
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Using Novell Add-on Manager
Clicking the Novell Add-on Manager icon in the Control Center opens the Novell Add-on 
Manager dialog box. Use this dialog box to view and manage (add and remove) the list of 
add-on packages available. Add-ons that are selected in the list have been installed on 
your thin client.

To install add-ons, your thin client must be connected to the correct update server and 
folder on that server. If you receive a Failed to download available add-on list error 
message, click Server Settings in the Novell Add-on Manager dialog box to open and 
use the Thin Client Settings dialog box as described in "Configuring the Image Upgrade 
Options" (IMPORTANT: In the Update Server URL text box, be sure to enter the root path 
on the server followed by the path to the Addons folder). The Novell Add-On Manager 
populates the list with add-ons listed in the directory plain text file located in the addons 
folder (see "Step 1: Preparing the Root Directory and Folder Structure on the File Server"). 

Use the following guidelines to install and uninstall add-ons:
• Installing add-ons - Select the check box of the add-on and click Execute.
• Uninstalling add-ons - Clear the check box of the add-on and click Execute.

Power Management
Clicking the Power Management icon in the Control Center opens the Power 
Management Preferences dialog box. Use this dialog box to select On AC Power 
(actions and display), On Battery Power (actions and display for mobile thin clients), 
General (actions, notifications, and extras), and Scheduling (automatic wake-up) power 
preferences. Press the Power button to wake the computer from standby or sleep mode.
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Setting Screensaver Preferences
Clicking the Screensaver icon in the Control Center opens the Screensaver Preferences 
dialog box. Use this dialog box to select screen saver theme settings and power 
management settings (click Power Management to open and use the Power 
Management Preferences dialog box - see "Power Management").

Tip
Press the Power button to wake the computer from standby or sleep mode.

Viewing System Information
Clicking the System Information icon in the Control Center opens the System 
Information dialog box. Use this dialog box to view Identity, Network, System Log, and 
Copyright information:
• Identity tab - Displays identity information such as Website, Terminal Name, Product 

Name, Platform, Build, SLETC, OS Version, CPU Type, CPU Speed, RAM Size, RAM 
Free, Flash Size, Serial Number, and BIOS Version.

• Network tab - Displays network information such as Interface, MAC Address, Network 
Speed, IP Address, IPv6 Address, Subnet Mask, Gateway, Domain Name, Primary 
DNS, Secondary DNS, DHCP Server, Lease, and Elapsed time.

• System Log tab - Displays the System Log information, including various messages 
generated during the operation of the thin client.

• Copyright tab - Displays the software copyright and patent notices.
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Using TCX USB Virtualizer
Clicking the TCX USB Virtualizer icon in the Control Center opens the TCX USB 
Virtualizer Configuration Utility dialog box. Use this dialog box to view and manage 
(add, edit, and delete) the list of current device classes (on the Configuration tab) and to 
view the list USB devices enabled or denied for use on the thin client (on the USB Devices 
tab). You can deny a device class, but still permit a USB device in that class to be used, by 
adding it to the Devices list of the Configuration tab.

Use the following guidelines:
• Enabling USB devices - Select the Enabled check box (default).
• Allowing or denying USB device classes - On the Configuration tab, select or clear 

the check box of a device class in the Devices list to allow or deny its use. For 
example, select Smart Card Devices to permit USB smart card devices to be used to 
log into virtual machines.

• Adding a USB device - On the Configuration tab, click Add to open the Add dialog 
box, enter a Device Name, select a class for the device from the Class list, enter the 
Sub Class, Vendor ID, Protocol, and Product ID, and then click Add. After you reboot 
your thin client, the name of the new device appears on the Configuration tab.

Tip
You can obtain device Class, Sub Class, Protocol, Vendor ID, and Product ID 
information by plugging the device into the USB port of your thin client and 
viewing the information displayed in the USB Devices tab.

• Allowing or denying a USB device - After you add a USB device, its name appears 
on the Configuration tab. Select or clear a USB device check box to allow or deny its 
use.

Caution
Use caution when using TCX USB Virtualizer on a terminal server, as 
allowing use of a USB device is global and not session restricted.

For information on the TCX USB Virtualizer component of Wyse TCX Suite software, refer 
to "Wyse TCX Suite."
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Managing Thin Client Users
Clicking the Thin Client Users icon in the Control Center opens the Thin Client Users 
dialog box. Use this dialog box to easily view all users (both built-in and those defined 
through INI files).

Caution
While this dialog box allows you to edit the passwords and automatic login 
for users of the thin client, you must use central configuration (INI files) to 
add or delete users beyond the built-in default users provided. In general, it is 
recommended that you use user.ini files to manage (add, edit, or delete) 
users for normal use cases. For example, a new user should be created 
through a user.ini file with the appropriate privilege level defined in the text 
file. 

To edit a user, select a user, and then click Edit User to open and use the Edit User 
dialog box (be sure to click OK after your configurations).

Tip
The Edit User dialog box for a user can be a convenient way to change the 
Password and enable automatic login for a specific user.
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Setting VNC Server Preferences for Shadowing
Clicking the VNC Server icon in the Control Center opens the VNC Server Preferences 
dialog box. Use this dialog box to select Sharing, Security, and Notification VNC Server 
preferences for use with remote administration. For example, you can set the Security 
password (the password an administrator must use when shadowing the thin client) in this 
dialog box.

Tip
For information on shadowing a thin client, see "Administrators Only - Using 
VNC Viewer for Remote Administration (to Shadow a Thin Client)."



46 Chapter 4
Administrators Only - Using VNC Viewer for Remote Administration (to 
Shadow a Thin Client)

VNC Server is installed locally on the thin client (see "Setting VNC Server Preferences for 
Shadowing"). It allows a thin client to be operated/monitored (shadowed) from a remote 
machine on which VNC Viewer is installed (VNC Viewer is included as a component of 
Wyse Device Manager software). This allows a remote administrator to configure or reset 
a thin client from a remote location rather than making a personal appearance at the thin 
client site (VNC is intended primarily for support and troubleshooting purposes). The VNC 
server starts automatically as a service at thin client startup. The service can also be 
stopped and started by using the Services window (opened by clicking Start > Control 
Panel > Administrative Tools > Services).

Before an administrator on a remote machine (on which VNC Viewer is installed) can 
access a thin client (with the VNC server utility installed) the administrator must know the:
• IP Address (or valid DNS name) of the thin client that is to be operated/monitored (see 

"Viewing System Information"). To obtain the IP address of an administrator thin client, 
hover the mouse arrow over the VNC icon in the system tray of the Administrator 
taskbar.

• Security Password of the thin client that is to be operated/monitored (see "Setting VNC 
Server Preferences for Shadowing").

To shadow a thin client from a remote machine:

1. Double-click the VNC Viewer icon to open the Connection Details dialog box. 

2. Enter the IP address or valid DNS name of the thin client that is to be operated/
monitored (shadowed) followed by a colon and 0. For example:  
snoopy:0 
or 
132.237.16.238:0

Tip
You can also click Options and configure other settings of the Connection 
Details dialog box (see "Setting VNC Viewer Options").

3. Click OK to open the VNC Authentication dialog box. 

4. Enter the Session password of the thin client that is to be shadowed (this is the 
Security Password of the thin client that is to be shadowed) and click OK. The thin 
client that is to be operated/monitored will be displayed for the administrator in a 
separate window on the remote machine. Use the mouse and keyboard on the remote 
machine to operate the thin client just as you would if you were operating it locally.
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Setting VNC Viewer Options
VNC Viewer software is included as a component of Wyse Device Manager software and 
must be installed on the remote (shadowing) machine. You can configure advanced VNC 
connection options using the Connection Options dialog box. For example, if the 
network is slow, click Options (in the Connection Details dialog box of the VNC Viewer) 
to open the Connection Options dialog box, select the Restrict Pixels to 8-bit check 
box in the Display area (reduces color depth for better transmission speed), and then click 
OK to return to the Connection Details dialog box.

Use the following guidelines (options vary for different VNC software releases):
• Preferred encoding options - Normally the VNC Viewer requests CopyRect, Hextile, 

CoRRE and RRE in that order. The selection alters this behavior by specifying the 
encoding method to be used before any of the others are tried. 
Allow CopyRect encoding - When selected, VNC Viewer informs the VNC Server it 
can cope with CopyRect encoding. 
Custom compression level - When selected, you can adjust the overall compression 
level you want. 
Allow JPEG compression - When selected, you can adjust the JPEG compression 
level you want.

• Misc options: 
Request shared session - When you make a connection to a VNC Server, all other 
existing connections are normally closed. This option requests that they be left open, 
allowing you to share the desktop with someone already using it. 
Deiconify on Bell - Often a beep will sound because you are being notified of 
something such as e-mail arriving or a compilation finishing. This selection causes a 
minimized VNC Viewer to be restored when the bell character (escape sequence) is 
received. 
Disable clipboard transfer - Clipboard changes caused by cutting or copying at either 
the VNC Viewer or the VNC Server are normally transferred to the other end. This 
option disables clipboard transfers.

• Mouse options: 
Emulate 3 Buttons (with 2-button click) - When selected, users with a two-button 
mouse can emulate a middle button by clicking both buttons at once. 
Swap mouse buttons 2 and 3 - Generally selected by left-handed persons.

• Display options: 
Restrict pixels to 8-bit (for slow networks) - When selected, reduces color depth for 
better transmission speed.  
View only (inputs ignored) - Select this option if you only want to monitor the desktop 
of the remote thin client but do not want to operate it using the keyboard and mouse. 
Full-screen mode - Causes the connection to start in full-screen mode. 
Scale by - Experimental usage of scaling is provided.
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Configuring the WDM Agent
Clicking the Wyse WDM icon in the Control Center opens the WDM Agent Configuration 
dialog box. Use this dialog box to configure the Wyse Device Manager server location.

Tip
It is recommended that after configuring, you reboot the thin client.

To configure the WDM server location.

1. Enter the WDM Server IP address.

2. Enter the Client to Sever Port (default, is 80).

3. Enter the Secure Port (HTTPS port default is 443).

4. Click OK.



5 Using and Configuring Connections 
with the Connection Manager
This chapter provides information and detailed instructions on using and configuring 
connections to access the enterprise server environment available to the thin client.

Tip
Configurations made in the Connection Manager only apply to the thin client 
you are using. If you want to configure more than one thin client at a time or 
configure thin clients remotely, Wyse recommends configuring thin client 
settings using INI files as described in "Automating Thin Client 
Configurations and Updates." 

Clicking the Connection Manager icon in the Computer menu (see "Using the Computer 
Menu") or in the Application Browser (see "Accessing Applications with the Application 
Browser") opens the Connection Manager. You can use the Connection Manager to view, 
use, and configure connections on the thin client.

Use the Connection Manager to:
• Add connections (see "Adding Connections Overview")
• Edit connections (select a connection, click Edit, and then follow the guidelines for 

configuring the connection in "Adding Connections Overview")
• Delete connections (select a connection and click Delete)
• Connect to connections (select a connection and click Connect)
• Access the Control Center (click Control Center)
• Log off, shut down, suspend, or restart the thin client (click Logout)

Tip
The Connection Manager features a user can access depends on the 
privilege level (set by the administrator). For example, a low privilege level 
allows a user to view and use the connections available, but does not allow 
the user to configure and edit connections.
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Adding Connections Overview
Use the following guidelines:

1. In the Connection Manager, click Add to open the Add Connection dialog box.

2. Select the type of connection you want from the list and click Next.

3. Configure the connection using the appropriate procedures from the following list:
• "Adding Mozilla Firefox Browser Connections"
• "Adding Custom Connections"
• "Adding Ericom PowerTerm® TEC Connections"
• "Adding Ericom PowerTerm® WebConnect Connections"
• "Adding ICA Connections"
• "Adding RDP Connections"
• "Adding SSH Connections"
• "Adding VMware View Client Connections"
• "Adding VNC Viewer Connections"
• "Adding XDMCP Connections"
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Adding Mozilla Firefox Browser Connections
1. In the Connection Manager, click Add to open the Add Connection dialog box.

2. Select Browser from the list and click Next to open the Mozilla Firefox Browser 
Configuration dialog box.

3. Use this dialog box to configure the settings you want. After configuring the settings 
you want, click OK. The connection appears in the Connection Manager and is ready 
to use.

Network 
Use the Network tab to configure the description and URL (optional if you want the 
browser to open to a particular Web page each time you connect). If you want the browser 
to launch automatically after system startup, select the Auto Connect check box.

Window 
Use the Window tab to configure how the browser window is displayed. If you want the 
browser to appear without any menus or toolbars, select Kiosk Mode. Select the Window 
Size you want from the list. 

Auto Reconnect 
Use the Auto Reconnect tab to enable automatic reconnect after a disconnection (select 
the Enable Auto Reconnect check box, and then select the amount of time to delay the 
reconnection attempt after a disconnection occurs).
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Adding Custom Connections
1. In the Connection Manager, click Add to open the Add Connection dialog box.

2. Select Custom from the list and click Next to open the Custom Connection 
Configuration dialog box.

3. Use this dialog box to configure the settings you want. After configuring the settings 
you want, click OK. The connection appears in the Connection Manager and is ready 
to use.

Application 
Use the Application tab to configure:
• Description - Enter the description.
• Command Line - Enter the command line for the program on the server.
• Run in terminal window - Runs the application in a terminal window (use with 

applications that require a terminal window such a console program).
• Auto Connect - Starts the connection automatically after system startup.

Auto Reconnect 
Use the Auto Reconnect tab to enable automatic reconnect after a disconnection (select 
the Enable Auto Reconnect check box, and then select the amount of time to delay the 
reconnection attempt after a disconnection occurs).
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Adding Ericom PowerTerm® TEC Connections
1. In the Connection Manager, click Add to open the Add Connection dialog box.

2. Select Ericom_PowerTerm from the list and click Next to open the Terminal 
Emulator Configuration dialog box.

3. Use this dialog box to configure the settings you want. After configuring the settings 
you want, click OK. The connection appears in the Connection Manager and is ready 
to use.

Network 
Use the Network tab to configure the network settings:
• Network Connection or Serial Connection - Select Network Connection for 

connections over TCP/IP, or Serial Connection for connections through a serial port.
• Description - Enter a description for the connection.
• Host - Enter a host name or IP Address (or select one from the list). Host can be 

populated from the global Ericom — PowerTerm® TEC connection application.
• Port - Enter the port of the host.
• Terminal Type - Select a terminal type.
• Terminal Name - Enter a name for the terminal.
• Save Configuration Locally - Saves the font, color, key-mapping and other settings of 

the Ericom — PowerTerm® TEC application locally.

Window 
Use the Window tab to select the Window Size you want.

Connection 
Use the Connection tab to configure the connection settings:
• Auto Connect - Starts the connection automatically after system startup.
• Ping Before Connect - Pings the connection to see if it is reachable before the 

connection is attempted.
• Auto Reconnect - Reconnects automatically after a disconnection occurs.
• Delay before retrying - Select the amount of time to delay the reconnection attempt 

after a disconnection occurs.
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Setting 
Use the Setting tab to automatically run script during user logon (enter the script name 
and path).

Remote Configuration 
Use the Remote Configuration tab to configure:
• Remote Configuration Filename - Enter the remote configuration filename for the 

connection.
• Remote Configuration Path - Enter the remote configuration path for the connection.

View 
Use the View tab to select the items that will appear when using the connection (menu, 
toolbar, status bar, and buttons).
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Adding Ericom PowerTerm® WebConnect Connections
1. In the Connection Manager, click Add to open the Add Connection dialog box.

2. Select Ericom_Webconnect from the list and click Next to open the Terminal 
Emulator Configuration dialog box.

3. Use this dialog box to configure the settings you want (Server can be a host name or 
IP Address). After configuring the settings you want, click OK. The connection appears 
in the Connection Manager and is ready to use.
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Adding ICA Connections

Tip
When using multiple ICA connections, you can use the ICA Connection 
Center to manage the open ICA connections. For more information on using 
multiple ICA connections, refer to the Wyse Knowledge Base on the Wyse 
Web site.

1. In the Connection Manager, click Add to open the Add Connection dialog box.

2. Select ICA from the list and click Next to open the Citrix ICA Client Settings dialog 
box.

3. Use this dialog box to configure the settings you want. After configuring the settings 
you want, click OK. The connection appears in the Connection Manager and is ready 
to use.

Network 
Use the Network tab to configure the network settings:
• Server or Published Application - Select an option for making the connection.
• Description - Enter a description for the connection.
• Network Protocol - Select a network protocol.
• Browser Server - Enter the Browser Server name (this can be a list of server names 

with each name separated by a semi-colon).

Tip
You do not need to enter a browser server name if you do not want to 
connect to either a published application or a server by name. Generating an 
ICA connection to a server using a server name in the Server text box for the 
connection does not require a Browser Server address, as long as the DNS 
information is properly entered.

• Server or Application Name - Select a server from the Server list or a published 
application from the Application Name list. If needed, click Refresh to refresh the list of 
servers or published applications.

Tip
You can enter the IP address of the target server as long as there is no need 
to resolve a name.
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Connection
Use the Connection tab to configure the connection settings:
• Enable compression - Enables compression.
• Low bandwidth - Enables low-bandwidth optimization.
• Enable sound - Enables sound.
• Ping before connect - Pings the connection to see if it is reachable before the 

connection is attempted.
• Enable Middle Button Paste - Enables middle button paste for the mouse.
• Encryption - Select an encryption type (default is Basic).

Window 
Use the Window tab to select the Window Colors and the Window Size you want.

Application 
Use the Application tab to enter the command line and Working Directory of the 
application (if you selected the Published Application option on the Network tab):
• Command Line - Enter the command line for the program on the server.
• Working Directory - Enter the working directory for the program.

Login 
Use the Login tab to configure credentials used to automatically log in to the server:
• User Name - Enter a user name for the connection.
• Password - Enter the password.
• Domain - Enter the domain name.
• Serial Number - Enter the serial number for Metaframe environments that require the 

thin client license serial number.
• Connect automatically after login - Enables an automatic connection after 

successful login to the thin client.

Tip
The User Name, Password, Domain, and Serial Number fields are optional. If 
the User Name, Password, and Domain fields are blank, interactive login is 
required (users must enter the information at login time).

Auto Reconnect 
Use the Auto Reconnect tab to enable automatic reconnect after a disconnection (select 
the Enable Auto Reconnect check box, and then select the amount of time to delay the 
reconnection attempt after a disconnection occurs).

Firewall 
Use the Firewall tab to configure an alternate address for firewalls:
• Automatically detect proxy - Select to automatically detect the proxy type.
• Use Alternate Address for Firewalls - Select Yes to use an alternate address for 

firewalls.
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• Proxy Type - Select a proxy type.
• Proxy Address and Port - If you select Secure (HTTPS) or SOCKS as the Proxy 

Type, you must enter the Proxy Address and Port.

Tip
Published applications do not support Firewall functions.
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Adding RDP Connections
1. In the Connection Manager, click Add to open the Add Connection dialog box.

2. Select RDP from the list and click Next to open the Remote Desktop (RDP) 
Configuration dialog box.

3. Use this dialog box to configure the settings you want. After configuring the settings 
you want, click OK. The connection appears in the Connection Manager and is ready 
to use.

Network 
Use the Network tab to configure the network settings:
• Description - Enter a description for the connection.
• Server - Enter a server name or IP address.
• Ping Before Connect - Pings the connection to see if it is reachable before the 

connection is attempted.
• Notify When Disconnected - Notifies you when the connection is broken.

Connection 
Use the Connection tab to configure the connection settings:
• Compression - Enables compression.
• NT4 compatible - Enables RDP protocol version 4.
• Low bandwidth - Enables low-bandwidth optimization.
• Sound - Select audio source for the connection (Local or Remote).
• Encryption Level - Select an encryption level (Normal or None).

Tip
For servers with data encryption settings, you must select Normal for the 
encryption level.
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Experience 
Use the Experience tab to configure the experience settings for a user desktop:
• Grab ALL keyboard events when window has focus - Enables all keyboard events 

within the connection window to always be sent to the connection’s applications.
• Menu and window animation - Enables menu and window animation.
• Show contents of window while dragging - Shows the window content when the 

user drags the window on screen.
• Desktop Background - Displays the desktop background.
• Speed Level - Select a speed level to describe the network connection.

Tip
Consider your network restrictions when you select options on the 
Experience tab. For example, be sure to configure the settings appropriately 
for your bandwidth level and so on.

Window 
Use the Window tab to select the Window Colors and the Window Size you want.

Application 
Use the Application tab to enter the command line and Working Directory of the 
application that will run at the beginning of a session:
• Command Line - Enter the command line for the program on the server.
• Working Directory - Enter the working directory for the program.

Login 
Use the Login tab to configure credentials used to automatically log in to the connection:
• User Name - Enter a user name for the connection.
• Password - Enter the password.
• Domain - Enter the domain name.
• Use smart card - Enables the use of a smart card when connecting.
• Connect automatically after login - Enables an automatic connection after 

successful login to the thin client.

Tip
The Username, Password, and Domain fields are optional. If you leave any 
of these fields blank, interactive login is required (users must enter the 
information at login time).

Auto Reconnect 
Use the Auto Reconnect tab to enable automatic reconnect after a disconnection (select 
the Enable Auto Reconnect check box, and then select the amount of time to delay the 
reconnection attempt after a disconnection occurs).
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Drive Mapping 
Use the Drive Mapping tab to map share names on the server to USB mass storage 
devices attached to the thin client, and to view and manage (add, edit, and delete) the list 
of current server share names (including drive information) mapped on the thin client.

Adding Share Names
1. Click Add to open the RDP Drive Map dialog box.

2. Enter a Share Name.

3. Select a Drive Type (USB Floppy, USB CDROM, USB Disk or Memory Stick, or 
Local or Mounted Disk).

4. (Optional) Enter the directory on the USB device to access in the Base Directory text 
box.

5. Click OK to add the Share Name to the list of available Share Names.

Editing and Deleting Share Names
To edit or delete a Share Name, select a Share Name from the list of available Share 
Names and do one of the following:
• Edit - Click Edit and configure the Share Name as described in "Adding Share 

Names."
• Delete - Click Delete to remove the Share Name.
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Device Mapping 
Use the Device Mapping tab to map devices to ports on the thin client, and to view and 
manage (add and delete) the list of current devices (including device information) mapped 
on the thin client.

Adding Devices
1. Click Add to open the Add Port Mapping dialog box.

2. Select a port from the Port list.

3. Select the directory of the device to access from the Device list. 

4. Click OK to add the device to the list of available devices.

Deleting Devices
To delete a device, select a device from the list of available devices and click Delete.
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Adding SSH Connections
1. In the Connection Manager, click Add to open the Add Connection dialog box.

2. Select SSH from the list and click Next to open the SSH Configuration dialog box.

3. Use this dialog box to configure the settings you want. After configuring the settings 
you want, click OK. The connection appears in the Connection Manager and is ready 
to use.

Network 
Use the Network tab to configure the network settings:
• Description - Enter a description for the connection.
• Host - Enter a host name or IP address.
• Remote Username - Enter a username.
• Remote Command - Enter the command to execute on the server.

Connection 
Use the Connection tab to configure the connection settings:
• Auto Connect - Starts the connection automatically after system startup.
• Ping Before Connect - Pings the connection to see if it is reachable before the 

connection is attempted.
• Auto Reconnect - Reconnects automatically after a disconnection occurs.
• Delay before retrying - Select the amount of time to delay the reconnection attempt 

after a disconnection occurs.
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Adding VMware View Client Connections
Use the following guidelines:

1. In the Connection Manager, click Add to open the Add Connection dialog box.

2. Select VMware_ViewClient from the list and click Next to open the VMware View 
Client Settings dialog box.

3. Use this dialog box to configure the settings you want. After configuring the settings 
you want, click OK. The connection appears in the Connection Manager and is ready 
to use.

Tip
No special client-side configuration is needed to enable PCOIP connections. 
This is configured on the View broker, and once a user logs in from the client 
and obtains a list of desktops, they will be presented with an option to choose 
PCOIP or RDP (based on server settings).

Network 
Use the Network tab to configure the network settings:
• Description - Enter a description for the connection.
• Host - Enter a host name or IP address.
• Port - Enter the port of the host.
• Use Secure Connection (SSL) - Select to use an SSL connection.
• Enable interactive mode - Enables interactive mode.

Window 
Use the Window tab to select a Display size and whether to use full screen on all monitors.

Login 
Use the Login tab to configure credentials used to automatically log in to the connection:
• User Name - Enter a user name for the connection.
• Password - Enter the password.
• Domain Name - Enter the domain name.
• Desktop - Enter the desktop name.
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Connection 
Use the Connection tab to configure the connection settings:
• Ping Before Connect - Pings the connection to see if it is reachable before the 

connection is attempted.
• Connect automatically after login - Enables an automatic connection after 

successful login to the thin client.
• Auto Reconnect - Reconnects automatically after a disconnection occurs.
• Delay before retrying - Select the amount of time to delay the reconnection attempt 

after a disconnection occurs.
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Adding VNC Viewer Connections
1. In the Connection Manager, click Add to open the Add Connection dialog box.

2. Select VNC_Viewer from the list and click Next to open the VNC Viewer Settings 
dialog box.

3. Use this dialog box to configure the settings you want. After configuring the settings 
you want, click OK. The connection appears in the Connection Manager and is ready 
to use.

Network 
Use the Network tab to configure the network settings:
• Description - Enter a description for the connection.
• Host - Enter a host name or IP address.
• Connect to - Select a connection type of either Display number (enter the display to 

connect to on the server) or Port number (enter the port to connect to on the server).
• Ping Before Connect - Pings the connection to see if it is reachable before the 

connection is attempted.

Connection 
Use the Connection tab to configure the connection settings:
• Compression Level - Select a compression level for encoding.
• Shared - Enables or disables a shared connection.
• View Only - Blocks mouse and keyboard events for a view-only connection.

Window 
Use the Window tab to configure window settings:
• JPEG Quality - Specifies the image quality for encoding.
• Full Screen - Opens the connection in a full-screen window.
• Color Depth - Controls how many colors to display with each on-screen pixel.

Login 
Use the Login tab to configure credentials used to automatically log in to the VNC server:
• Password - Enter the password to connect to the VNC server.
• Connect automatically after login - Enables an automatic connection after 

successful login to the thin client.
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Adding XDMCP Connections
1. In the Connection Manager, click Add to open the Add Connection dialog box.

2. Select XDMCP from the list and click Next to open the XDMCP Client Settings dialog 
box.

3. Use this dialog box to configure the settings you want. After configuring the settings 
you want, click OK. The connection appears in the Connection Manager and is ready 
to use.

Network 
Use the Network tab to configure the network settings:
• Description - Enter a description for the connection.
• Host - Enter a host name or IP address of an XDMCP server.
• Connect Style - Select a connection mode: Query, Chooser, or Broadcast.
• Connect Program - Select the program through which the connection is made: Xnest 

or Xserver.

Window 
Use the Window tab to select the Window Colors and the Window Size you want.

Connection 
Use the Connection tab to configure the connection settings:
• Auto Connect - Starts the connection automatically after system startup.
• Ping Before Connect - Pings the connection to see if it is reachable before the 

connection is attempted.
• Auto Reconnect - Reconnects automatically after a disconnection occurs.
• Delay before retrying - Select the amount of time to delay the reconnection attempt 

after a disconnection occurs.
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6 Accessing Applications with the 
Application Browser
This chapter provides detailed information about using the Application Browser to access 
the applications, audio and video, and system features installed on the thin client.

Tip
For a list of supported addons you can install, contact Wyse. For information 
on adding and managing addons, refer to "Automating Thin Client 
Configurations and Updates" and "Using Novell Add-on Manager."

Clicking More Applications in the Computer menu (see "Using the Computer Menu") 
opens the Application Browser. You can use the Application Browser to access the 
applications, audio and video, and system features installed on the thin client.

This chapter includes information on:
• "Performing Diagnostics"
• "Managing the Ericom PowerTerm® TEC Servers Available for Connections"
• "Configuring Volume Control Settings"
• "Taking Screenshots"
• "Using XTerm"

Tip
Clicking the Connection Manager icon in the Application Browser opens the 
Connection Manager. You can use the Connection Manager to view, use, 
and configure connections on the thin client as described in "Using and 
Configuring Connections with the Connection Manager."
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Performing Diagnostics
Clicking the Diagnostics icon in the Application Browser opens the Diagnostics dialog 
box. Use this dialog box to select and use a diagnostic tool:
• Ping - Enter or select a destination from the Destination list and click Ping.
• Trace Route - Enter or select a destination from the Destination list and click Trace 

Route (diagnostic information appears on the Trace Route tab).
• Temporary Settings - View the temporary settings of the thin client.
• Permanent Settings - View the permanent settings of the thin client.
• wlx.ini/wnos.ini - View the wlx.ini or wnos.ini file as copied to the thin client.
• user.ini - View the user.ini file as copied to the thin client.

Managing the Ericom PowerTerm® TEC Servers Available for Connections
Clicking the Ericom PowerTerm icon in the Application Browser opens the Ericom 
PowerTerm Terminal Emulation dialog box. Use this dialog box to view and manage 
(add and delete) the list of servers that are presented when an Ericom PowerTerm® TEC 
connection is being configured for thin client access to network resources as described in 
"Adding Ericom PowerTerm® TEC Connections."

Use the following guidelines:
• Adding a hostname - Click Add to open the Add host dialog box, enter a Hostname, 

and then click OK. The hostname is added to the Hostname list.
• Deleting a hostname - Select a hostname and click Delete. The hostname is removed 

from the Hostname list.
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Configuring Volume Control Settings
Clicking the Volume Control icon in the Application Browser opens the Volume Control 
dialog box. Use this dialog box to select Playback (system sounds), Recording 
(application recording sounds), Output Devices (left and right sounds), Input Devices (left 
and right sounds), and Configuration (profile) volume preferences. You can use the Show 
list on the Playback, Recording, Output Devices, and Input Devices tabs to select which 
items you want shown.

Tip
For these settings to take effect, sound must be supported and enabled on 
the server used for ICA connections, RDP connections, or MPlayer. Sound 
requires significant bandwidth that may not be available on some WAN and 
dial-up connections.

Taking Screenshots
Clicking the Take Screenshot icon in the Application Browser opens the Take 
Screenshot dialog box. Use this dialog box to select screenshot preferences and effects 
(for example, entire desktop with pointer, current window with a border, or a selected 
area). After setting your preferences, click Take Screenshot to take the screenshot and 
open the Save Screenshot dialog box allowing you to name and save the file.
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Using XTerm
Clicking the XTerm icon in the Application Browser opens the terminal emulator window 
for X (XTerm is the standard terminal emulator for the X Window System). XTerm allows 
you access to a text terminal and all its applications such as command line interfaces 
(CLI) and text user interface applications. You can click the Window menu (upper left icon) 
to open and use the XTerm menu. You can type help and press Enter to have XTerm 
display a verbose message describing its options.
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